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1 Introduction 
The TCS3410 evaluation kit comes with everything needed to evaluate the TCS3410. The 

device features digital ambient light sensing (ALS) and flicker detection. 

1.1 Kit content 

Figure 1: Evaluation kit content 

 

No. Item Description 

1 TCS3410 Daughter Board PCB with TCS3410 sensor installed 

2 EVM Controller Board Used to communicate USB to I²C  

3 USB Cable (A to Micro-B) Connects EVM controller to PC 
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1.2 Ordering information 

 

Ordering code Description 

TCS3410_EVM_KT TCS3410 Evaluation Kit  

 

2 Getting started 
Install the software before connecting any hardware to the computer. Follow the instructions in 

the Quick Start Guide (QSG) to install the software, which loads the required driver for the 

USB interface and the device’s graphical user interface (GUI).  

This user guide identifies and describes the controls available on the GUI. Combined with the 

TCS3410 datasheet, the QSG, and application notes available on the ams OSRAM website 

(ams-osram.com), there should be enough information to evaluate the TCS3410 device. 

3 Hardware description 
The hardware includes the EVM Controller, the TCS3410 EVM daughter board, and a USB 

interface cable. The EVM controller board provides power and I²C communication to the 

daughter board through a ten-pin connector. When the EVM controller is connected to the PC 

through USB, a green LED on the board lights to indicate the system is getting power. This 

LED will be turned off when the GUI program starts so that it does not interfere with light 

measurements. 

Figure 2: Evaluation kit hardware 
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4 Software description 
The main window (Figure 3) contains the system menus, system-level controls, device 

information, and logging status. The Configuration tab contains controls to set up both ALS 

and Flicker detection parameters. The ALS tab and SW Flicker tab display ALS data, Flicker 

data, and Mod Gain data. The ALS tab contains a plotting area in which raw ALS data is 

drawn. The SW Flicker tab contains a plotting area in which the flicker raw data and flicker 

frequency after FFT calculation are drawn. The application polls the ALS and flicker raw data 

continuously, and calculates flicker frequency values. 

Figure 3: GUI main window 
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4.1 Software to hardware connection 

On startup, the software automatically connects to the hardware. On successful initialization, 

the software displays a main window, containing controls pertinent to the connected device. If 

the software detects an error, an error window appears. If “Device not found or is unsupported” 

appears, verify the correct daughterboard is properly connected to the EVM controller board. If 

“Cannot connect to EVM board” appears, verify the USB cable is connected. When the EVM 

controller board is connected to the USB, a green LED on the board lights indicating the USB 

cable is connected and supplying power to the system. 

If the EVM board disconnects from the USB bus while the program is running, the program 

displays an error message and then terminates. Reconnect the EVM board and restart the 

program. 
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4.2 System menus 

At the top of the window there are pull-down menus labeled “File”, “Log”, and “Help”. The File 

menu provides basic application-level control. The Log menu controls the logging function, 

and the Help menu provides version and copyright information for the application. 

4.2.1 File menu 

The File menu contains the following functions: 

Figure 4: File menu 

 

The Reread Registers function forces the program to reread all the control registers from the 

device and display them on the screen. This does not read the output data, because the 

program reads those registers continually while it is running. 

Click on the Exit command to close the main window and terminate the application. This clears 

any unsaved log data is cleared from memory. The application can also be close by clicking 

the red “X” in the upper right-hand corner. 
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4.2.2 Log menu 

The Log menu controls the logging function and saves the log data to a file. Log data 

accumulates in memory until discarded or written to a data file. 

Figure 5: Log menu 

 

Click Start Logging to start the logging function. Each time the program polls the output 

information from the device, it creates a new log entry showing the raw data values, the values 

of various control registers, and the values entered by the user into the text fields near the 

bottom right corner of the window. 

Click Stop Logging to stop the logging function. Once logging stops, the user can store the 

data in a file, or continue collecting additional data by clicking Start Logging again. 

The Log a Single Entry command causes logging to start, collect one single entry, and 

immediately stop again. This function is not available when logging is already running. 

Click Clear Log to discard any previously collected data. If there is data in memory, that has 

not been saved to the disk, this function displays a prompt asking for verification to discard the 

data. If the log is active when this function executes, the log continues running after the 

existing data is discarded. 

Click Save Log to save the collected log data to a CSV file. This stops the logging function, if it 

is active, and displays a file dialog box to specify where to store the logged data. The Log 

status and control Information section below describes the default file name, but you may 

change the file name if desired. 
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4.2.3 Help menu 

The Help menu contains a single function: About. 

Figure 6: Help menu 

 

The About function displays a dialog box (Figure 7) showing the version and copyright 

information for the application and library. Click the OK button to close this window and 

continue. 

Figure 7: About window 

 

4.3 System level controls 

Immediately below the top menu bar are checkboxes used to control the system-level 

functions of the TCS3410 device. 

The Power On checkbox controls the PON function of the TCS3410. When this box is 

checked, the power is on, and the device runs measurements according to the settings in the 
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Configuration tab. The Configuration tab is disabled to prevent users from changing the 

settings while the measurement is ongoing. When this Power On checkbox is unchecked, the 

power is off, and the device does not operate. The Configuration tab is then enabled, and the 

user can change the controls to set up the parameters for the next run. 

4.4 Auto polling 

The application automatically polls the TCS3410 raw data of ALS and Flicker if enabled. The 

Poll Interval, at the upper right corner of the form, displays the actual time between the reads 

of the device. The control “Poll Interval” in the middle bottom of the form lets the user set the 

desired polling interval. 

4.5 Device ID information 

The lower left corner of the window displays the ID number of the EVM Controller board, 

identifies the device being used, and displays the ID of the device. 

4.6 Log status and control Information 

The lower right corner of the window contains status information and controls for the logging 

function: 

Figure 8: Logging status 

 

This section contains text boxes that are stored in the log file data and used to build the file 

name for the log file. If the data in these fields are changed, the new values are stored with any 

new data logged. The default file name is based on these values at the time the log file is 

written. If nothing is entered in these boxes, they default to a period (“.”). 
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Sample of a default file name: 

TCS3410_1-2-3_Log_HH_MM_SS.csv 

  From Application 

  From User Input 

The Count value displayed is a count of the number of samples currently in the log buffer. 

The Elapsed Time value indicates the elapsed time since data logging started. 

The numeric box in the bottom right-hand corner sets a limit to the size of the collected 

dataset. You may select a value from the pull-down list or enter a value manually. When the 

number of entries in the log reaches this value, the program will automatically stop logging and 

display a file dialog box to specify where to store the logged data. You may change the file 

name if desired. The maximum value that can be entered in this field is 32000. 

4.7 “Configuration” tab 

The main portion of the screen contains a tab labeled Configuration. 

Figure 9: Configuration tab 
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4.7.1 Configuration controls 

The SAMPLE TIME control sets the time of one flicker measurement. It also defines the 

measurement time of the step for ALS measurements. 

The Flicker group box contains controls relating to flicker detection:  

• Flicker Enable control enables the flicker detection if checked.  

• FD Data Width control sets the width of the compressed flicker data in the FIFO. The 

values are from 1 to 15. 

• FD_NR_SAMPLES control defines the number of samples for one flicker measurement.  

• FD Measurement Time control displays the integration time for one flicker measurement. 

The ALS group box contains controls relating to flicker detection:  

• ALS Enable control enables the ALS detection if checked.  

• ALS_NR_SAMPLES control defines the number of samples for one ALS measurement.  

• ALS Integration Time control displays the integration time for one ALS measurement. 

The Calibration group box contains the following controls: 

• CALIB_NTH_ITERATION control sets the repeat rate of the calibration execution in the 

measurement sequencer rounds. The values are from 0 to 255.  

• Autozero at nth iteration checkbox enables auto zero calibration during the nth iteration 

calibration if checked. 

• OSC_CALIB control defines the calibration mode. The available options are “0 disabled”, 

“1 after pon”, and “2 always on”. 

• At VSYNC Frequency sets VSYNC frequency. The available values are 60Hz, 90Hz and 

120Hz. 

The Gains group box contains controls to set up all the gains: 

• Common Gain checkbox, if checked, will set all the channels to the same gain.   

• All Channels dropdown combo box sets the gain for all the channels if the Common Gain 

checkbox is checked. The choices are 1/2x, 1x, 2x, 4x, 8x, 16x, 32x, 64x, 128x, 256x, 

512x, 1024x, 2048x, 4096x and 8192x. 

• Max Gain dropdown combo box sets the max gain for all the channels if the Common 

Gain checkbox is checked. The choices are 1/2x, 1x, 2x, 4x, 8x, 16x, 32x, 64x, 128x, 

256x, 512x, 1024x, 2048x, 4096x and 8192x. 

• Gain at Channel 0/1/2 and Step 0/1/2 dropdown combo box sets the gain for channel 

0/1/2 at step 0/1/2 if the Common Gain checkbox is unchecked. The choices are 1/2x, 1x, 

2x, 4x, 8x, 16x, 32x, 64x, 128x, 256x, 512x, 1024x, 2048x, 4096x and 8192x.  
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• Gain at Channel 0 and step 3 sets the gain for channel 0 at step 3, which is for flicker 

detection. 

• AGC group box has two checkboxes. One is the Prediction checkbox for enabling the 

prediction of the AGC function for all steps of the sequence if checked. The second is the 

Saturation checkbox which enables AGC analog saturation if checked.  

• Residual checkbox enables a residual measurement on modulator 0 if checked. 

The WTime group box contains controls relating to the wait function:  

• MOD_TRIGGER_TIMMING defines the repeat rate of modulator/sequencer 

measurements. The available selections are “0 off”, “1 normal = 2.84 ms”, “2 long = 

45.51 ms”, “3 fast = 88.89 µs”, “4 fastlong =1.42 ms”, “5 vsync”, “6 reserved0” and “7 

reserved1”.  

• WTIME specifies the time to wait between measurement steps. The values are from 0 to 

255.  

The AGC Time group box contains controls to set up the AGC time:  

• AGC_NR_SAMPLES defines the number of samples for every AGC measurement. The 

values are from 0 to 65535. 

• AGC Integration Time displays the AGC integration time.  
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4.8 “ALS” tab 

The main portion of the screen contains a tab labeled ALS. It displays measurement data. 

Figure 10: ALS tab 

 

4.8.1 ALS group box 

The lefthand side of the ALS tab displays the ALS measurement data with the following items:  

• The ALS Integration time. 

• Clear data counts. 

• Red data counts. 

• Green data counts. 

• Blue data counts. 

• Wide band data counts. 

• Clear data saturation status: A green color means no saturation happened. A red color 

means otherwise. 

• Red data saturation status: A green color means no saturation happened. A red color 

means otherwise. 
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• Green data saturation status: A green color means no saturation happened. A red color 

means otherwise. 

• Blue data saturation status: A green color means no saturation happened. A red color 

means otherwise. 

• Wide band data saturation status: A green color means no saturation happened. A red 

color otherwise. 

• Lux: Lux calculation is not implemented in the GUI. 

• Gain: Normalized Gain value. This is the gain value of channel 0 in step 0 for clear data 

detection. 

• The Tune radio buttons: This set of radio buttons prevents the plotting graph values from 

jumping dramatically due to the AGC effect of different normalized gain values applied 

when measuring. The displayed data is the measurement data ratio when normalized gain 

has the selected value (of the radio button). 

4.8.2 Flicker sampling group box 

The following items display in the Flicker Sampling group box:  

• Sampling Time 

• Sampling Frequency 

• FD_GAIN 

• Flicker Frequency1, which has the biggest FFT value. 

• Flicker Frequency2, which has the second biggest FFT value. 

• Flicker Frequency3, which has the third biggest FFT value. 

4.8.3 Gains group box 

In this group box, there is the nine gain value matrix for modulator 0/1/2 and step0/1/2. 

4.8.4 ALS data plot 

The remaining portion of the ALS tab is used to display a running plot of the collected ALS 

values and calculated Lux. The last 350 values are collected and plotted on the graph. As 

additional values are added, the old values will be deleted from the left side of the graph. To 
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start the plotting function, check the Enable Plot checkbox and select the ALS, IR, or Lux 

checkboxes. 

Figure 11: ALS data plot 

 

The scale of the Y-axis of the plot can be adjusted by clicking on the small up and down 

arrows at the top left corner of the plot. The scale can be set to any power of 2 from 64 through 

65536. 

Click the Clear Plot button to discard the current data and continue plotting the new data. Note 

that if the Clear Plot button is clicked while the plot is disabled, the data is discarded, but the 

actual plot will not be updated until the plot function is re-enabled. 
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4.9 “SW flicker” tab 

The main portion of the screen contains a tab labeled SW Flicker. 

Figure 12: SW flicker tab 

 

4.9.1 Flicker information 

The left side of the SW Flicker tab displays the same ALS and Flicker information as in the 

ALS tab. See chapter 4.8 for detailed information. 

4.9.2 Flicker output data 

The top right-hand section of the SW Flicker tab displays a plot of the original flicker data and 

the data after FFT. Besides, the peak Flicker Frequency, the compression rate are also 

displayed there. 
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Figure 13: SW flicker data plot 

 

The scale of the Y-axis of the plot can be adjusted by clicking on the small up and down 

arrows at the top left corner of the plot. The scale can be set to any power of 2 from 16 to 

16384. 

Click the Clear Plot button to discard the current data and continue plotting the new data. Note 

that if the Clear Plot button is clicked while the plot is disabled, the data is discarded, but the 

actual plot will not be updated until the plot function is re-enabled. 

5 Resources 
For additional information regarding the TCS3410, please refer to the datasheet. For 

information regarding the installation of the TCS3410 EVM host application software, please 

refer to the TCS3410 EVM Quick Start Guide. 

Designer’s Notebooks dealing with various aspects of optical measurement and optical 

measurement applications are available. All content is available on the ams OSRAM website 

ams-osram.com. 
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Reference documents:  

• TCS3410 Datasheet, DS000752 

• TCS3410 EVM Quick Start Guide (QSG), QG000168 

• TCS3410 EVM User’s Guide (this document), UG000504 
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6 Revision information 
Definitions 

Draft / Preliminary: 
The draft / preliminary status of a document indicates that the content is still under internal review and subject to change without notice. ams-OSRAM 
AG does not give any warranties as to the accuracy or completeness of information included in a draft / preliminary version of a document and shall 
have no liability for the consequences of use of such information. 

 

Changes from previous released version to current revision v2-00 Page 

Document contents were transferred to latest ams OSRAM template  

Updated Figure 1, Figure 2 and Figure 4 3, 4, 7 

Updated Ordering code 4 

 

● Page and figure numbers for the previous version may differ from page and figure numbers in the current revision. 

● Correction of typographical errors is not explicitly mentioned. 
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7 Legal information 
Copyright & disclaimer 

Copyright ams-OSRAM AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved. The material 

herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the copyright owner. 

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and evaluation purposes only and 

are not considered to be finished end-products intended and fit for general consumer use, commercial applications and applications with special 

requirements such as but not limited to medical equipment or automotive applications. Demo Kits, Evaluation Kits and Reference Designs have not 

been tested for compliance with electromagnetic compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation 

Kits and Reference Designs shall be used by qualified personnel only. 

ams-OSRAM AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time and without 

notice. 

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a particular purpose are 

disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or consequential damages arising from the inadequacy 

of the provided Demo Kits, Evaluation Kits and Reference Designs or incurred losses of any kind (e.g. loss of use, data or profits or business 

interruption however caused) as a consequence of their use are excluded. 

ams-OSRAM AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property damage, loss 

of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any kind, in connection with or arising out 

of the furnishing, performance or use of the technical data herein. No obligation or liability to recipient or any third party shall arise or flow out of ams-

OSRAM AG rendering of technical or other services. 

Headquarters 

ams-OSRAM AG 

Tobelbader Strasse 30 

8141 Premstaetten 

Austria, Europe 

Tel: +43 (0) 3136 500 0 

Please visit our website at ams-osram.com 

For information about our products go to Products 

For technical support use our Technical Support Form 

For feedback about this document use Document Feedback 

For sales offices and branches go to Sales Offices / Branches 

For distributors and sales representatives go to Channel Partners 
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